
Interacting with AutoCAD

AFTER COMPLETING THIS CHAPTER, YOU WILL BE ABLE TO:

Launch AutoCAD �

Maneuver the user interface �

Understand how to interact with AutoCAD �

CHAPTER 1 
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2 ■  CHAPTER 1 : INTERACTING WITH AUTOCAD

FIGURE 1.2:  Ω Launching AutoCAD via the Start menu

At startup, AutoCAD will launch a New Features Workshop window. This window 

will give you the option to view or not view the new features of the software and 

to keep the window from launching at startup. The New Features Workshop (Fig-

ure 1.3) can also be accessed using the Help menu at any time. To continue launch-

ing your session of AutoCAD, follow these steps:

 1. Click the No button with the left mouse button.

 2. Click the OK button with the left mouse button.

AutoCAD 2008’s new features will be discussed in a later chapter.

A new AutoCAD drawing session will launch. This drawing session will typi-

cally launch in the 2D Drafting and Annotation AutoCAD Workspace (Figure 1.4). 

This workspace contains the new toolbars and features associated with the current 

release.

Launching AutoCAD

Autodesk, the makers of AutoCAD, usually release a new version of the software 

every year. With each new release, the software becomes more streamlined to 

make it easier to use. New toolbars and functions are also added to enable the user 

to work more efficiently. The overall interface is not markedly different between 

the versions. If you are using AutoCAD release 2006 or 2007, you should be able to 

quickly adapt, although your screen interface will not have the newest functions of 

the current release. Regardless of the release you are using, understanding how to 

interact with AutoCAD is important.

Launching AutoCAD via the Shortcut Icon

AutoCAD is launched similarly to other Windows-based software applications: either 

via the shortcut icon on your computer’s desktop or the Start menu. (See Figure 1.1.) 

To launch AutoCAD via the shortcut icon, do the following:

Double-click the AutoCAD shortcut icon with the left mouse button.

FIGURE 1.1:  Ω Launching AutoCAD 
via the shortcut icon

Launching AutoCAD via the Start Menu

To launch AutoCAD using the Start menu, do the following:

 1. Click the Start menu (Figure 1.2) with the left mouse button. 

 2. Select All Programs with the left mouse button. Navigate to the Autodesk 

folder and click it with the left mouse button.

 3. Select AutoCAD 2008 or the version of the software that is currently loaded on 

your computer. Click the left mouse button.

This action will launch a new session of AutoCAD.
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STARTING A NEW SESSION OF AUTOCAD  ■ 3

Because users have different releases of AutoCAD, these examples will launch 

the AutoCAD Classic Workspace (Figure 1.5). This workspace launches similarly to 

past releases of AutoCAD. To launch this workspace, do the following:

With the left mouse button, click the AutoCAD Classic Workspace selection 

from the Workspaces toolbar.

FIGURE 1.5:  Ω The AutoCAD Classic Workspace

Starting a New Session of AutoCAD 

To start a new session of AutoCAD using the pulldown menu, follow these steps:

Click File and select New with the left mouse button.

To start a new session of AutoCAD using the command line, follow these steps:

Type new and press the Enter key on the keyboard, or click the right mouse 

button (right-click) and select Enter from the tooltip window.

FIGURE 1.6:  Ω The New Drawing icon

FIGURE 1.3:  Ω The New Features Workshop window

FIGURE 1.4:  Ω The 2D Drafting and Annotation AutoCAD Workspace
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The Save As Function

To save a file using the pulldown menu, do the following:

Click File and select Save As with the left mouse button.

To save a file using the command line, do the following:

Type Save and press the Enter key on the keyboard, or click the right mouse 

button and select Enter from the tooltip window.

To name and save your drawing file, do the following:

 1. Click the File pulldown menu and select Save As with the left mouse button. 

The Save Drawing As window will launch, as in Figure 1.8.

 2. Navigate to the appropriate folder on your computer.

 3. Name your file Review-Ch1 by entering the information in the File Name area.

 4. Click the Save button with the left mouse button.

These steps will save your drawing file to the folder that you selected. This is 

critical because every 10 to 15 minutes AutoCAD will back up your drawing once it 

has been saved using a default setting. 

FIGURE 1.8:  Ω The Save Drawing As window

Selecting a Template

Now that the software has been launched, start a new drawing file using a template. 

The software comes with many default templates already added. To access these 

templates, do the following:

 1. Click the File pulldown menu and select New with the left mouse button. A 

Select Template window will launch, as in Figure 1.7.

 2. Select the acad or acad.dwt template with the left mouse button.

 3. Click the Open button with the left mouse button.

This action will start a new drawing file.

FIGURE 1.7:  Ω The Select template window
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Setting Drawing Limits

To set drawing units using the pulldown menu, do the following:

Click Format and select Drawing Limits with the left mouse button.

To set drawing units using the command line, do the following:

Type limits and press the Enter key on the keyboard, or type limits and 

right-click.

Drawing limits are usually set so that objects drawn will be scaled to fit on your 

display. Drawing limits are based on the ultimate page size of your final drawing. The 

ultimate page size will be dictated by the overall size and dimensions of your draw-

ing. For example, if you are drawing a 100,000 square-foot floor plan, obviously, it 

will not fit on an 8½˝ × 11˝ page size at an acceptable scale. 

Floor plans are generally drawn at a scale of 1⁄8˝=1´-0˝ or ¼˝=1´-0 ,̋ and elevations 

are drawn at a scale of ¼˝=1´-0˝ or ½˝=1´-0 .̋ Therefore, you will need to take into 

account the size of your project and the drawing scale prior to setting the drawing 

limits. However, it is possible to draw outside the drawing limits. To set the drawing 

limits, do the following:

 1. Click Format and select Drawing Limits with the left mouse button. 

Command Line Prompt:

Command: Reset Model space limits:
Specify lower-left corner or [On/Off] <0’-0”,0’-0”>:

 2. Press the Enter key on the keyboard, or right-click and select Enter from the 

tooltip window. 

Command Line Prompt:

Command:  Reset Model space limits:
Specify upper-right corner <1’-0” ,0’-9”>:

 3. To enter a drawing limit for a page size that is 24˝× 36 ,̋ do the following:

Type 36,24 on the command line and press the Enter key, or enter 36,24 and 

right-click.

Your drawing limits will be set and the command will end.

Setting Drawing Units

To set drawing units using the pulldown menu, do the following:

Click Format and select Units with the left mouse button.

To set drawing units using the command line, do the following:

Type ddunits and press the Enter key on the keyboard, or right-click and 

select Enter from the tooltip window.

Next, the drafting units will need to be set for your drawing. In order to set them 

to architectural units, do the following:

 1. Click the Format pulldown menu and select Units with the left mouse button. 

A Drawing Units window will launch.

 2. In the Length section, click the Type pulldown menu, and click Architectural 

with the left mouse button.

 3. Click the OK button with the left mouse button.

This action will set your drawing units to architectural and close the Drawing 

Units window. (See Figure 1.9.)

FIGURE 1.9:  Ω The Drawing Units window
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The software Control buttons (Figures 1.12 and 1.13) control the operation of the 

session. The top series of buttons within the current-drawing name band controls 

the AutoCAD session, and the buttons directly below them control the current 

 drawing session. The left button will minimize the current session, the middle but-

ton will maximize the current session, and the right button will close the current 

session.

FIGURE 1.12:  Ω The Control buttons — 
AutoCAD Session

FIGURE 1.13:  Ω The Control buttons — 
Current drawing session  

The toolbar in Figure 1.14 allows access to all of the commands and procedures. 

Using the pulldown menus is only one way to execute commands.

FIGURE 1.14:  Ω The pulldown menus

The Info Center toolbar (Figure 1.15) allows you to access to the AutoCAD Help 

menu.

FIGURE 1.15:  Ω The Info Center toolbar

The Standard toolbar (Figure 1.16) is typically launched at startup and includes 

many of the standard icons.

FIGURE 1.16:  Ω The Standard toolbar

The Drawing toolbar (Figure 1.17) contains the basic drawing command icons.

FIGURE 1.17:  Ω The Drawing toolbar

Maneuvering the User Interface

Before you can create any drawings, you must be familiar with the AutoCAD inter-

face (Figure 1.10). Here is a brief overview of its major elements.

Draw Toolbar Modify Toolbar

UCS Icon

Model and Layout Tabs

Pulldown Menus

Command Line Status Bar

Layers Toobar Standard Toobar

Current Drawing Name Control Buttons

FIGURE 1.10:  Ω The AutoCAD interface

Components of the AutoCAD Interface

The band in Figure 1.11 identifies the name of the current drawing file.

FIGURE 1.11:  Ω The name of the current drawing
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Interacting with AutoCAD

In order to draw 2D drawings, you can use either AutoCAD or AutoCAD LT. The dif-

ferences between the two are slight with regard to preparing 2D drawings. AutoCAD 

LT is a less expensive program with approximately 80 percent of the functionality of 

AutoCAD. Basically, Autodesk removed the 3D capabilities of AutoCAD and some of 

the customization functions, making it considerably more affordable for casual users 

and small firms that don’t need to create 3D drawings or that will use alternative 

software such as SketchUp to prepare 3D drawings.

The following are some useful tips when interacting with AutoCAD.

Naming AutoCAD Files

When you are naming AutoCAD files, take special care when you are using symbols. 

The only symbols that you should use are the following:

The dash (—)• 

The underscore (_ )• 

The period (.)• 

Any other symbols could corrupt your drawing file, rendering it useless. Numbers 

and letters (whether uppercase or lowercase) can be used.

Layers

One of the major benefits of using AutoCAD is that your drawing is composed of 

layers. Typically, geometry is drawn once and subsequent information is added to 

the drawing on separate layers. When a new session of AutoCAD is launched, layer 

0 is the default layer. Think of layer 0 as your main/transfer drawing layer. The Layer 

Properties Manager (Figure 1.24) manages all of the layers and the properties of 

your drawing.

FIGURE 1.24:  Ω The Layer Properties Manager

The Modify toolbar (Figure 1.18) contains the basic modifying command icons.

FIGURE 1.18:  Ω The Modify toolbar

The Model space tab (Figure 1.19) is where you can access the drawing/model 

space of your drawing session.

FIGURE 1.19:  Ω The Model space tab

The Crosshair tool (Figure 1.20) is the selection cursor. 

FIGURE 1.20:  Ω The Crosshair  

The UCS icon (Figure 1.21) identifies the User Coordinate System. The Y-axis is 

the vertical plane, and the X-axis is the horizontal plane. The intersection of the two 

coordinates represents 0,0.

FIGURE 1.21:  Ω The UCS icon

The command line (Figure 1.22) is the area of the screen that allows keyboard 

entry.

FIGURE 1.22:  Ω The command line

The tabs on the Status bar (Figure 1.23) control the status of the drawing aids.

FIGURE 1.23:  Ω The Status bar
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To search or recall a toolbar, do the following: 

Hover over any icon visible in your drawing session and right-click. The corre-

sponding toolbar menu will launch. This list will show a check mark next to any 

toolbar that is currently docked in your drawing.

To make a particular toolbar visible, do the following:

Click the name of a toolbar that does not have a check mark with the left 

mouse button.

This action will add the toolbar to your drawing and either dock it to an available 

location or place it in the model space area of your drawing and close the Available 

Toolbar menu. (See Figure 1.26.)

FIGURE 1.26:  Ω The Available Toolbar menu

Model Space

All of the elements of your drawing should be drawn within model space at a 1:1 ratio.

Command Entry

Commands can be executed in many ways. It’s up to you to decide which way is the 

easiest:

Using the command line• 

Using icons• 

Using pulldown menus• 

Regardless of the command-entry method used, it’s important to follow along 

with the command line. The command line will guide you through the steps to per-

form a given function. It’s important to insert information when AutoCAD prompts 

you and then press the Enter key to continue. Other prompts to be aware of on the 

command line are items within angled brackets (< >) or regular brackets ([ ]). Inside 

angled brackets are the default settings of the command. To accept the default, sim-

ply press the Enter key. Items enclosed in brackets are options that you can choose. 

These options are keywords, and the first letter of the word is in uppercase. To 

select a particular option, simply type the uppercase letter and press the Enter key. 

New users should watch the command line closely when they are first learning to 

use a tool.

Tooltip Windows

When you are learning to draw, you should try several different ways of entering the 

commands. Using the icons can be the easiest way to execute commands. In order 

to familiarize yourself with the icons, hover your cursor over any icon. A small tooltip 

window will appear, identifying that icon. (See Figure 1.25.)

FIGURE 1.25:  Ω A tooltip window

Available Toolbar Menu

AutoCAD has many available toolbars from which you can choose. Not all of the 

toolbars are visible on your display when the software is first launched. You may 

inadvertently click or move a toolbar and turn it off. 
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To access the additional functions/options of that icon, do the following:

 1. Click and hold the bottom-right area of the icon at the arrow.

This action will launch the flyout menu and make the other functions/options 

visible.

To choose a different function/option, do the following:

 2. While still holding down the left mouse button, scroll down to another icon 

within the flyout menu and select that icon after it is highlighted and release 

the left mouse button.

This action will start the command for that icon.

FIGURE 1.30:  Ω An executed flyout menu

Clearing a Command

At times you may inadvertently start a wrong command or enter an incorrect prompt 

within a command. To clear or cancel that command, do the following:

Press the Esc key.

This action will stop the running command, enabling you to perform your next 

command. 

Docked/Floating Toolbars

When a new drawing session is launched, default toolbars are docked within your 

display. Docked toolbars (Figure 1.27) are set in the same location every time the 

software is launched. Floating toolbars (Figure 1.28) sometimes appear within the 

model space area of your display. Although floating toolbars can remain exactly 

where they are, it is a good idea to dock them to an available location within your 

display because your viewable drawing space is at a premium. To dock a floating 

toolbar within your display, do the following:

 1. Click and hold the top band of the floating toolbar with the left mouse button.

 2. Drag your cursor to an available space at the perimeter of your display and 

release the left mouse button.

Clicking, dragging, and droppping will dock the toolbar at that location.

FIGURE 1.27:  Ω A docked toolbar

FIGURE 1.28:  Ω A floating toolbar

The Three-Button Mouse

Familiarity with your mouse is key. A three-button mouse enables you to do the 

following:

The • left mouse button will execute a Pick command.

The • right mouse button will execute the Enter command.

The • middle mouse button or the wheel will execute the Zoom or Pan 

command.

Flyout Menus

On any given toolbar, flyout menus (Figures 1.29 and 1.30) contain icons that offer 

additional functions/options of the same command. Any icon that contains a flyout 

menu will have an arrow located at the bottom-right corner of the visible icon.

FIGURE 1.29:  Ω An icon with 
a flyout menu marker
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Closing an AutoCAD Drawing

To close an AutoCAD drawing using the pulldown menu, do the following:

Click File and select Close with the left mouse button.

To close an AutoCAD drawing using the command line, do the following:

Type close and press the Enter key on the keyboard, or right-click and select 

Enter from the tooltip window.

To close a drawing session of AutoCAD, do the following:

 1. Click the File pulldown menu and select Close with the left mouse button. An 

AutoCAD Save Changes window will launch.

 2. To save the drawing file, select the Yes button with the left mouse button.

This action will save the changes to your drawing and close the drawing file. (See 

Figure 1.32.)

FIGURE 1.32:  Ω The AutoCAD Save Changes window

AutoCAD Drawing File Extensions

File extensions or suffixes identify a file’s format. With AutoCAD there are several 

file extensions that you may encounter. However, the two most common are .dwg 

and .bak.

Repeating Command Entries

You may need to end commands and restart them again, one after another. Although 

it is possible to access the command via the command-entry method you find easi-

est, another way to begin the command is to recall it. To recall past entries or the 

last command entered (Figure 1.31), do the following:

 1. Right-click or press the Enter key. A tooltip window will display, enabling you 

to recall the last command and give you the option to choose from previously 

entered commands.

 2. Hover your cursor over the option to select and click it with the left mouse 

button.

FIGURE 1.31:  Ω The Recall Command 
Entry tooltip window

Unit Entry

When the drafting units of your drawing are set to architectural, AutoCAD will rec-

ognize any numerical entry as inches. For example, to draw a line that is 2´-6 ,̋ the 

command-line entry would be either 2´6˝ or 30 .̋
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AutoCAD Drawing File

The information in the AutoCAD Save Changes window shows the path to where 

your drawing is saved. If you selected the Yes option, your drawing was saved and 

closed to the location you originally designated. The suffix appended to all AutoCAD 

drawings is .dwg. (See Figure 1.33.)

FIGURE 1.33:  Ω The AutoCAD File icon

AutoCAD Backup Drawing File

Backup AutoCAD files are created in the same folder as the original drawing. The 

suffix that is appended to these drawings is .bak. These files can be useful if the 

original file becomes corrupt. The backup file can be renamed by changing the suffix 

from .bak to .dwg. Once done, the drawing file can be opened and used. All of the 

work completed at the time the drawing was last saved and closed should be avail-

able. (See Figure 1.34.)

FIGURE 1.34:  Ω The AutoCAD 
Backup File icon
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